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FOR WRITING THE BACHELOR 

THESIS/DISSERTATION  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Cluj-Napoca 

2025–2026



 

 

STEPS FOR WRITING  

THE BACHELOR THESIS/DISSERTATION  
 

1. In the period October-November of each academic year, the process of choosing the scientific 

coordinator and research topic of the bachelor thesis/dissertation takes place. This process 

encompasses a series of steps and dates mentioned on the Faculty of Business website.  

2. Present an outline of the bachelor thesis/dissertation (i.e., table of contents/structure) to the 

scientific coordinator. 

3. Complete the structure of the paper and theoretical foundation, establish the research 

methodology as well as submit these materials to the secretary office through an MS Teams 

assignment, until the date mentioned in the Calendar for the elaboration of the bachelor 

thesis/dissertation posted on the Faculty of Business website.  

4. Finalise 90% of the paper (the research is carried out, the research results and their discussions 

are completed, the conclusions are outlined) and submit this form of the paper to the secretary 

office through an MS Teams assignment, until the date mentioned in the Calendar for the 

elaboration of the bachelor thesis/dissertation. 

5. Complete the paper and submit it to the secretary office through an MS Teams assignment, until 

the date mentioned in the Calendar for the elaboration of the bachelor thesis/dissertation. 

6. Based on the thesis/dissertation, the scientific coordinator establishes the grade for the course 

“Elaboration of the bachelor's/dissertation thesis”. 

7. Receive the acceptance report of the bachelor thesis/dissertation from the scientific coordinator.  

8. Prepare the PowerPoint presentation for the bachelor thesis/dissertation defence.  

9. Discuss the PowerPoint presentation with the scientific coordinator.  

10. Fill in a declaration regarding the originality and non-plagiarism of the content of the bachelor 

thesis/dissertation. 

11. Submit the bachelor thesis/dissertation and all the requested documents to the secretary office 

through an MS Teams assignment. 

12. Defend the bachelor thesis/dissertation. 

 

IMPORTANT NOTE 1:  

Please make sure that you meet the deadlines set by your scientific coordinator.   
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IMPORTANT NOTE 2:  

For using AI in your thesis/dissertation, please consider the recommendations 

included in the Student Guide to Using Generative Artificial Intelligence Tools.  
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1.1.  

BACHELOR THESIS COVER  

should be formatted as follows:  
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BABEŞ-BOLYAI UNIVERSITY 

FACULTY OF BUSINESS 

(TNR 16pt) 
 

 

 

 

 

 

 

 

Bachelor thesis (TNR 26pt) 
 

 

 

 

 

 

 

 

 

 

Scientific coordinator, (TNR 14pt) 

Prof.Dr. Name Surname 
or 

Assoc.Prof.Dr. Name Surname 
or 

Assist.Prof.Dr. Name Surname 

                                                                                                 

                                    Student, (TNR 14pt) 

                                                                           Name Surname 
 

 

 

 

 

 

 

 

Cluj-Napoca 

2026 

 
 TNR = Times New Roman 
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1.2.  

BACHELOR THESIS FIRST PAGE 

should be formatted as follows:  
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BABEŞ-BOLYAI UNIVERSITY 

FACULTY OF BUSINESS 

SPECIALIZATION  

BUSINESS ADMINISTRATION  

or 

BUSINESS ADMINISTRATION IN HOSPITALITY SERVICES 

(TNR 16pt) 
 

 

 

 

 

 

Bachelor thesis (TNR 26pt) 

Title of the thesis (TNR 26pt) 
 

 

 

 

 

 

 

 

Scientific coordinator, (TNR 14pt) 

Prof.Dr. Name Surname 
or 

Assoc.Prof.Dr. Name Surname 
or 

Assist.Prof.Dr. Name Surname 

 

Student, (TNR 14pt) 

       Name Surname 
 

 

 

 

 

 

 

 

Cluj-Napoca 

2026 
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2.1.  

DISSERTATION COVER 

should be formatted as follows:  
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BABEŞ-BOLYAI UNIVERSITY 

FACULTY OF BUSINESS 

(TNR 16pt) 
 

 

 

 

 

 

 

 

Dissertation (TNR 26pt) 
 

 

 

 

 

 

 

 

 

 

Scientific coordinator, (TNR 14pt) 

Prof.Dr. Name Surname 
or 

Assoc.Prof.Dr. Name Surname 
or 

Assist.Prof.Dr. Name Surname 

                                                                                                 

                                   Student, (TNR 14pt) 

                                                                          Name Surname 
 

 

 

 

 

 

 

 

 

Cluj-Napoca 

2026 
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2.2.  

DISSERTATION FIRST PAGE 

should be formatted as follows:  
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BABEŞ-BOLYAI UNIVERSITY 

FACULTY OF BUSINESS 

SPECIALIZATION  

INTERNATIONAL BUSINESS ADMINISTRATION  

or 

BUSINESS ADMINISTRATION IN INTERNATIONAL 

HOSPITALITY AND TOURISM 

  (TNR 16pt) 
 

 

 

 

 

 

Dissertation (TNR 26pt) 

Title of dissertation (TNR 26pt) 

 
 

 

 

Scientific coordinator, (TNR 14pt) 

Prof.Dr. Name Surname 
or 

Assoc.Prof.Dr. Name Surname 
or 

Assist.Prof.Dr. Name Surname 

 

                                                                                                Student, (TNR 14pt) 

                                                                                                Name Surname 
 

 

 

 

 

 

 

 

Cluj-Napoca 

2026 
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3.  

BACHELOR THESIS AND 

DISSERTATION CONTENT 

 

 

 

 

 
 

 

IMPORTANT NOTE:  

The content of the bachelor thesis/dissertation will be evaluated 

both by the scientific coordinator and by each member of the 

defence committee, based on the assessment criteria and their 

quota, which can be found in the Appendix to the Guidelines for 

writing the bachelor thesis/dissertation.  
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It is recommended to have the following sections of the bachelor 

thesis/dissertation, depending on the type of work established together with the 

scientific coordinator:  

 

 

Scientific/Journal Article 

Manuscript type 

Case Study 

Manuscript type 

Introduction  

Description of the chosen research topic, 

its overarching aim, objectives and 

research question, etc. 

Introduction  

Brief summary of the case study, its 

overarching aim and research objectives. 

Literature Review and Research 

Methodology 

Review of academic literature related to 

the research topic.  

Presentation of the research method(s) 

and data sources used. 

If applicable, one can mention the 

research hypothesis/hypotheses. 

General Information on the Case Study 

If appropriate and/or necessary, one can 

refer to academic literature relevant to 

the case study topic. 

Research Methodology  

If applicable, one can mention how the 

study was conducted, which were the 

specific circumstances, how data were 

collected. 

Relevant Details on the Conducted 

Research 

Relevant Details on the Case Study 

Results and Discussion Results and Discussion 

Conclusions and 

Proposals/Recommendations 

Conclusions and 

Proposals/Recommendations 

IMPORTANT NOTES:  

1. Conclusions and proposals/recommendations have to be directly linked to the 

research topic of the bachelor thesis/dissertation and must be grounded on the 

results stemming from the conducted research.   

2. The business plan is a special manuscript type, which will be elaborated 

following the plan structure and the scientific coordinator’s recommendations. 
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Depending on the manuscript type, one may have the following Table of contents 

of the bachelor thesis/dissertation: 

 

TABLE OF CONTENTS 
 

List of Tables (TNR 14) ...........................................................................................p. 
 

List of Figures (TNR 14) .........................................................................................p. 
 

List of Acronyms and Abbreviations (TNR 14) ....................................................p. 
 

Abstract (TNR 14) ...................................................................................................p. 
 

Introduction (TNR 14) ............................................................................................p. 
 

Chapter 1. Literature Review and Research Methodology (TNR 14) ................p. 
 

or 
 

Introduction and General Information on the Case Study (TNR 14) ................p. 
 

Chapter 2. Title (TNR 14) .......................................................................................p. 

2.1. Subchapter 1 (TNR 13) .........................................................................................p. 

2.2. Subchapter 2 (TNR 13) .........................................................................................p. 

2.3. ..... 
 

Chapter 3. Title (TNR 14) .......................................................................................p. 

3.1. Subchapter 1 (TNR 13) .........................................................................................p. 

3.2. Subchapter 2 (TNR 13) .........................................................................................p. 

3.3. ..... 

......................................... 
 

Conclusions and Proposals/Recommendations (TNR 14) ....................................p.  
 

References (TNR 14) ...............................................................................................p. 
 

Appendix/Appendices (if necessary) (TNR 14) 
 

IMPORTANT NOTES:  

1. The Table of Contents must be automatically generated by using the References tab and 

Table of Contents button from MS Word!!!  

2. Pages must be numbered starting with the Introduction and ending with the last page of the 

References.  

3. Appendix/Appendices is/are not included in the total number of pages. 

4. The general structure with chapters (presented above) remains unchanged. It can be modified 

only with permission granted by the scientific coordinator.   
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3.  

DETAILS ON THE BACHELOR 

THESIS AND DISSERTATION 

CONTENT 
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Abstract (max. 1 page) 

In this first part of the bachelor thesis/dissertation the student/master student will 

write a summary of the research conducted, emphasizing the aim of the research study, 

research methodology, the conclusions that have been reached and the 

proposals/recommendations that have been formulated on the topic.  

 

Introduction ‒ if the manuscript type of the bachelor thesis/dissertation is 

Scientific/Journal Article 

In the Introduction the student/master student must: 

• Start with an overview and importance of the research topic. 

• Motivate the choice of the topic and highlight the novelty of the research. 

• Specify the overarching aim, research objectives and research question of the 

bachelor thesis/dissertation.  

 

Literature Review and Research Methodology ‒ if the manuscript type of the 

bachelor thesis/dissertation is Scientific/Journal Article 

In the Literature Review and Research Methodology the student/master the 

student/master student must: 

• Present the current state of knowledge of the chosen research topic, i.e., briefly 

describe the main sources from the literature related to the research topic.  

• Indicate the research method(s) and data sources used.  

• If applicable, include research hypothesis/hypotheses. 

 

Introduction and General Information on the Case Study ‒ if the manuscript type 

of the bachelor thesis/dissertation is Case Study 

 In the Introduction and General Information on the Case Study, the student/master 

student must: 

• Start with an overview and importance of the research topic.  

• Present the general relevant information on the case study. If appropriate and/or 

necessary, cite academic literature related to the research topic of the case study.  

• Motivate the choice of the topic and highlight the novelty of the research. 

• Specify the overarching aim and research objectives of the bachelor 

thesis/dissertation.  
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• Indicate the research methods used in the thesis/dissertation.  

• If applicable, student/master student can mention the research design, data 

collection instruments, etc. 

 

Chapter(s) 

• It is recommended to use a compact structure of the chapters. Do not divide the 

subchapters in too many paragraphs that have only a few lines. One subchapter 

should have a length of at least one page.  

• Use the following page formatting: 

➢ Page format: A4 

➢ Margins: Top 2.54 cm, Bottom 2.54 cm, Left 2.54 cm, Right 2.54 cm, Gutter 

– left 0.5 cm, Header 1.27 cm, Footer 1.27 cm 

➢ Paragraph first line indentation: 1 cm 

➢ Font: Times New Roman 12 pt, line spacing 1.5 lines, Justify 

• Please do not use empty lines/spaces between paragraphs! 

• Figures and tables will be aligned using the Center button in the Home tab and 

numbered as follows:  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.1. Evolution of income/household member (12pt) 
Source: Author(s)’ surname(s) (publication year, page/pages) (11pt) 

 

 

 

 
 If the Figure is made by the student and is not taken from other sources, then after Source one should write “Own 

work”. 
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Table 1.1. Evolution of income/household member (12pt) 

Income bracket Absolute frequency Relative frequency (%) 

[0.5;0.7] 6 16.33% 

(0.7;0.9] 8 32.65% 

(0.9;1.1] 12 48.98% 

(1.1;1.3] 8 67.35% 

(1.3;1.5] 9 85.71% 

(1.5;1.7] 3 91.84% 

(1.7;1.9] 4 100.00% 

 50 100% 

Source: Author(s)’ surname(s) (publication year, page/pages) (11pt) 
 

 

Conclusions and Proposals/Recommendations 

This last section of the bachelor thesis/dissertation should include the final 

conclusions drawn from the conducted research and the proposals/recommendations 

that stem from the concluding remarks. 

Personal opinions and proposals/recommendations on the research will have a 

major role in the evaluation of the bachelor thesis/dissertation. 

 

References 

• The reference list and the in-text citations have to follow the APA referencing 

style. This will be done in Microsoft Word by selecting the button Style → APA 

from the References menu. 

• To include references in the bachelor thesis/dissertation, one must use the 

following in-text citation style: author(s) surname(s), publication year ‒ for a 

journal article ‒ and author(s) surname(s), publication year, page number(s) ‒ for 

a book or a book chapter.  

 

 
 If the Table is made by the student and is not taken from other sources, then after Source one should write “Own work”. 

 

Table no. Chapter 

no. 
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• Citing a source in text will be done in Microsoft Word as follows:  

➢ One introduces the source in the References menu: 

→ Manage Sources → New → Type of Source → Book or Book Section 

(aka Book Chapter), in case the source is a book or a book chapter; 

→ Manage Sources → New → Type of Source → Journal Article, in case 

the source is a journal article; 

→ Manage Sources → New → Type of Source → Website, in case the 

source is a website;  

➢ One chooses the phrase in which to include the citation;  

➢ One selects the option Insert Citation from the References menu;  

➢ One selects the source that must be cited. 

• One must not use footnotes to indicate references.  

• The References at the end of the manuscript will be generated as follows: 

Bibliography → References from the References menu.  

• Each source in the References must be accompanied by the link to the source and, 

where applicable, by its DOI (Digital Object Identifier). 

• Once the References are generated, the sources will appear in alphabetical order 

by the first author(s) surname(s). One can divide sources into different categories, 

i.e., Books, Journal Articles, Articles or Documents Downloaded from the 

Internet, Webpages, Internal Documents, Other Documents Please.  

• Examples of different sources are presented below:  

 

➢ Books:  

Carlsson-Szlezak, P., & Swartz, P. (2024). Shocks, crises, and false alarms: How 

to assess true macroeconomic risk, Boston, Massachusetts: Harvard Business Review 

Press, ISBN 978-164-78-2540-9. 

➢ Journal Articles: 

Philippon, T., & Reshef, A. (2012). Wages and human capital in the U.S. finance 

industry: 1909-2006. The Quarterly Journal of Economics, 127(4), 1551‒1609. DOI 

10.1093/qje/qjs030. Available online at: https://academic.oup.com/qje/article-

abstract/127/4/1551/1843161. 

https://academic.oup.com/qje/article-abstract/127/4/1551/1843161
https://academic.oup.com/qje/article-abstract/127/4/1551/1843161
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➢ Articles or Documents Downloaded from the Internet: 

 Devlin, G. (2021). NYSE: The market for innovation. Available online at: 

https://www.nyse.com/article/nyse-the-market-for-innovation (accessed on 

10.10.2024). 

➢ Webpages: 

https://www.nyse.com/index (accessed on 12.10.2024) 

➢ Internal Documents: 

Apple 2030. Environment plan of company Apple. Available online at: 

https://www.apple.com/environment/.   

➢ Other Documents (e.g., national/international documents, annual statistics): 

Organization for Economic Co-operation and Development (2024).  Revenue 

statistics: Key findings for the United States. Available online at: 

https://www.oecd.org/unitedstates/revenue-statistics-united-states.pdf (accessed on 

10.10.2024). 

National Institute of Statistics (2021). Turnover of market services rendered 

mainly to enterprises. Available online at: https://insse.ro/cms/en/content/turnover-

market-services-rendered-mainly-enterprises-76 (accessed on 10.10.2024). 

 

 

 

 

 

 

 

 

IMPORTANT NOTES:  

1. All in-text citations should appear in the References and, vice versa, all sources 

that appear in the References should be cited in the text.  

2. Do not use Wikipedia as a source for the bachelor thesis/dissertation! 

https://insse.ro/cms/en/content/turnover-market-services-rendered-mainly-enterprises-76
https://insse.ro/cms/en/content/turnover-market-services-rendered-mainly-enterprises-76
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FINAL RECOMMENDATIONS 

• Bachelor thesis/dissertation will focus on the practical side of the research. 

Theoretical notions will exclusively support the practical research and will be 

briefly presented. 

• It is recommended that the final version of the bachelor thesis be around 40–50 

pages and the dissertation around 30–40 pages. 

• When the thesis thesis/dissertation is completed, before it is handed in to the 

scientific coordinator, the student must check its similarity index (i.e., plagiarism 

index) in the Turnitin platform installed on the computer found in the faculty 

library or through the account created by the scientific coordinator for each 

student. If this index exceeds 20%, the student must implement the necessary 

changes to decrease it below 20%.  

• Once the thesis/dissertation is handed in to the scientific coordinator, he/she 

checks its similarity index (i.e., plagiarism index) in the Turnitin platform. The 

scientific coordinator will grant the student the right to present the work in front 

of the bachelor thesis/dissertation committee only if this similarity index of the 

work is below the 20%, threshold established through the Regulations for 

completing the studies framework of the Faculty of Business.        

• The student will submit the electronic version of the bachelor thesis/dissertation 

along with the application/enrollment file for the bachelor thesis/dissertation 

defence to the secretary office. The deadline for submitting the bachelor 

thesis/dissertation is announced on the faculty website. 
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BACHELOR THESIS/DISSERTATION 

DEFENCE/PRESENTATION 

 

1. One will prepare the presentation of bachelor thesis/dissertation in a PowerPoint 

file. 

2. It is recommended to use the following structure of the presentation: 

• Slide 1: It is the same as the first page of the bachelor thesis/dissertation 

• Slide 2: Contains the aim, objectives and research question of the study 

• Slide 3: Contains the Research Methodology 

• Slide 4, Slide 5, Slide 6, etc.: Presents the Research Findings 

• Third-to-last slide: Contains the Conclusions 

• Second-to-last slide: Contains the Proposals/Recommendations 

• Last slide: Contains the text “Thank you!” 

• It is recommended not to use (too many) animation or transition effects on the 

slides. 

3. Allotted time for presenting the bachelor thesis/dissertation is, usually, 7–10 

minutes, followed by a Q&A session of 5 minutes.  

4. It is recommended to present without reading the text from the slides and to 

have appropriate attire and attitude. 

 

 

 

 

 

 

 

 

 

IMPORTANT NOTE:  

The defence of the bachelor thesis/dissertation will be evaluated by each member of 

the defence committee  based on the assessment criteria and their quota, which can 

be found in the Appendix to the Guidelines for writing the bachelor 

thesis/dissertation.  



 

 23 

APPENDIX 

To Guidelines for Writing the Bachelor Thesis/Dissertation 

 

Assessment Report of the Bachelor Thesis/Dissertation 

Presented in the July 2026/February 2027 Session and Filled in by 

SCIENTIFIC COORDINATOR 

 

 

Similarity index: ______ % for sequences containing 20 words, references excluded (maximum 

admitted percentage 20%)  

Average grade of the years of study: ____________________ 

 

Assessment Criteria Quota  

The relevance of the research topic (related to the author’s specialisation and the 

current context) 

5% 

Correlation of the title with the abstract, introduction and body of the paper 5% 

The work is structured and organised correctly, balanced and of normal size, 

respecting the requirements specified in the guidelines 
5% 

Theoretical background (where applicable) 

- demonstrates the author's ability to synthesise; 

- demonstrates the author's ability to master and use specialised theoretical 

concepts and notions; 

- the complexity and diversity of the studied sources; 

- is based on the appropriate use and citation of relevant and current sources; 

- the references are relevant; 

- the in-text citations and references are compiled following the APA style 

provided in the guidelines for writing the bachelor thesis/dissertation. 

15% 

The research methodology is appropriate for the chosen topic 

- the applicability, usefulness and originality of the paper (where applicable); 

- the (under)graduate student uses research methods, tools and techniques 

appropriate to the chosen research topic; 

- the tools used are based on academic literature related to the chosen research 

topic; 

- the data were properly collected, processed and correctly analysed; 

- the complexity of the analyses was carried out; 

10% 

Research results and discussions 

- the case study (where applicable) is comprehensive and relevant; 

- the calculated indicators are relevant and correctly interpreted; 

- the results obtained from the research (primary and or secondary) carried out 

were in depth analysed and correctly interpreted; 

- the complexity of discussions and interpretations; 

30% 
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Assessment Criteria Quota  

The conclusions and proposals are pertinent and derive from the results of 

research and analysis; 
10% 

The work complies with technical editing requirements 

- table of contents, page numbering, charts, figures and tables, appendices (if 

applicable), alignment, titles, subtitles, characters, spacing, etc. – according to the 

guidelines); 

- written expression denotes clarity and coherence; there are no grammatical and 

expression mistakes; 

- the figures, charts and tables used are correctly developed, original/correctly 

cited, relevant/useful/necessary and properly commented on; 

- the appendices are correctly developed, original/correctly cited, 

relevant/useful/necessary and properly commented on; 

10% 

Sources are cited accordingly 5% 

The student’s attitude towards the process of developing the bachelor 

thesis/dissertation (seriousness, promptness, receptivity to the changes requested 

by the scientific coordinator) 

5% 

Handing in the final paper by the maximum set deadline 

Sine qua 

non 

condition 

FINAL GRADE proposed by the scientific coordinator  

(Weighted average of the points awarded for each category above) 

 

 

OBSERVATIONS/COMMENTS: 

 

 

 

 

 

 

Date ________ 

Name, Surname and Signature of the Scientific Coordinator ______________________________ 
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Assessment Report of the Bachelor Thesis/Dissertation 

Presented in the July 2026/February 2027 Session and Filled in by 

MEMBER OF THE DEFENCE COMMITTEE 

 

Assessment Criteria Quota  

Grade proposed by the Scientific Coordinator: 30%  

The average grade of the years of study:  

Written exam grade for the bachelor exam (not applicable for graduates):  

SCIENTIFIC CONTENT (cumulated, 30% of the final grade) 

The relevance of the research topic (related to the author’s specialisation and the 

current context) 

2% 

Correlation of the title with the abstract, introduction and body of the paper 2% 

The work is structured and organised correctly, balanced and of normal size, 

respecting the requirements specified in the guidelines 
2% 

Theoretical background (where applicable) 

- demonstrates the author's ability to synthesise; 

- demonstrates the author's ability to master and use specialised theoretical 

concepts and notions; 

- the complexity and diversity of the studied sources; 

- is based on the appropriate use and citation of relevant and current sources; 

- the references are relevant; 

- the in-text citations and references are compiled following the APA style 

provided in the guidelines for writing the bachelor thesis/dissertation. 

3% 

The research methodology is appropriate for the chosen topic 

- the applicability, usefulness and originality of the paper (where applicable); 

- the (under)graduate student uses research methods, tools and techniques 

appropriate to the chosen research topic; 

- the tools used are based on academic literature related to the chosen research 

topic; 

- the data were properly collected, processed and correctly analysed; 

- the complexity of the analyses was carried out; 

3% 

Research results and discussions 

- the case study (where applicable) is comprehensive and relevant; 

- the calculated indicators are relevant and correctly interpreted; 

- the results obtained from the research (primary and or secondary) carried out 

were in depth analysed and correctly interpreted; 

- the complexity of discussions and interpretations; 

10% 

The conclusions and proposals are pertinent and derive from the results of 

research and analysis; 
3% 

The work complies with technical editing requirements 3% 
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Assessment Criteria Quota  

Grade proposed by the Scientific Coordinator: 30%  

The average grade of the years of study:  

Written exam grade for the bachelor exam (not applicable for graduates):  

SCIENTIFIC CONTENT (cumulated, 30% of the final grade) 

- table of contents, page numbering, charts, figures and tables, appendices (if 

applicable), alignment, titles, subtitles, characters, spacing, etc. – according to the 

guidelines); 

- written expression denotes clarity and coherence; there are no grammatical and 

expression mistakes; 

- the figures, charts and tables used are correctly developed, original/correctly 

cited, relevant/useful/necessary and properly commented on; 

- the appendices are correctly developed, original/correctly cited, 

relevant/useful/necessary and properly commented on; 

Sources are cited accordingly 2% 

Grade for Scientific Content:  

BACHELOR THESIS/DISSERTATION PRESENTATION 

(cumulated, 40% of the final grade) 

Quality of presentation (relevant information, little text, quality of written 

expression in PowerPoint presentation) 
10% 

Quality of presentation (quality of oral expression, speaking fluently, mastering 

concepts) 
10% 

Quality of presentation (efficient use of time) 4% 

Ability to answer questions and provide explanations 12% 

Overall attitude 4% 

Grade for Presentation:  

FINAL GRADE granted by the Member of the Defence Committee 

(The SUM of the points from above) 

 

 

OBSERVATIONS/COMMENTS: 

 

 

 

 

 

 

Date ________ 

Name, Surname and Signature of the Member of Defence Committee  

________________________________________________________ 

 

 


